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Recipient Information

UElo

TINe

Legal Entity
Name®@

Type©®

FAINO®

CFDA No.®

Fiscal Year
End Date

GDB7JUWP
35B3

646000658

County of
Madison

Metro City
or County

Sep 30,2 5

Address@

Address 20
Address 3@
Cityo
State/Territory
[ ]

Zip5e

Zip+4o

Reporting
Tiero

More

Please verify that you are an authorized user of the prime recipient
and confirm the accuracy of your organization's program profile.

146 West
Center
Street

Canton

MS

39046

Tier 2.
Metropolita
n cities and
counties
with a
population
below
250,000
residents
which
received
more than
$10 million
in SLFRF
funding

> Help

> Legend

Record
Details

Status
Draft

Report
Name
SLT-3349-P&E
Report-Q4
2022

Report Type
Project and
Expenditure
Report

Report
Period
Quarter 4
2022
(October-
December)

Reporting
Period Start
Date
10/1/2022

Reporting
Period End
Date
12/31/2022

Submission
Deadline
1/31/2023
10:59 PM

Allocated
Amount
$20,642,090.
00




*(required) s the Recipient

Registered in SAM.Gov?
“Non... v

Save

Point of Contact List

Name

1 GregHigginbotham

2 Na'Son White

3 NASONWHITE

N

Title v

County Administra...

Comptroller

Comptroller

Phone v

(601)855-5502 (te...

(601)855-5580 (te...

Next
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Add Projects Add Subrecipients/Ben...  Add Subawards/Direct... Add Expenditure(s)

Project Overview

Recipients are required to enter projects funded through SLFRF funds as
part of their Project and Expenditure Report. Projects can be entered,
viewed, and updated from this screen.

All projects, regardless of Expenditure Category, require a set of
“standard” data fields. Some of these fields, such as project name and
project ID, are static and do not change across reporting periods. Other
fields, such as status of completion and total obligations, will change
across reporting periods.

Note: Bulk Upload templates will appear once you have selected the
Project Expenditure Category

You may need to refresh your browser screen to see your new entries.

My Projects

= Complete © =Warning © =Not Complete @
Total Number of Projects : 1
Total Obligations: Total Expenditures: Total Adopted Budget:
$609,202.46 $347,564.19
o Add New
Project
> Filters
© Recordsperpage: 10 : Page: 1 of1
Recipient Total Total Expenditure

Project Name Project Status

Project Id ™  Obligations “~ Expenditures ~ Category

1 Broadband-Fibe.. BBFTH 11152021 $609,202.46 $347,564.19 5-Infrastructure

& Download as CSV

Back Next
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vqq pLolecrz

Add Subrecipi...

Add Subawar...  Add Expendit...

Subrecipients, Beneficiaries, or Contractors

Please provide identifying information for each Subrecipient,
Beneficiary, or Contractor that received at least one Subaward or
Direct Payment of federal funding greater than $50,000 from this
program. In addition, you will also need to provide information
about the Subrecipient's 2 CFR 170.330 Total Compensation

reporting, if applicable.

Subrecipient Information

Bulk Uploads

Download the Subrecipient Template

&
& Upload Subrecipient Template

Manual Entry

UEl:@

TIN:@

*(required) Legal Name: @

POC Email Address:®

* (required) City: @

*

Zipt4:0
(required) Zip:
L]

*(required) Address Line 1:@

Address Line 2:@

Address Line 3:@

(required)State: (required)Country:
o (i}

--Non... « Unite... +

S ———

e Details

> Help
> Legend

Record

Status
Draft

Report
Name
SLT-3349-P&E
Report-Q4
2022

Report Type
Project and
Expenditure
Report

Report
Period
Quarter 4
2022
(October-
December)

Reporting
Period Start
Date
10/1/2022

Reporting
Period End
Date
12/31/2022

Submission
Deadline
1/31/2023
10:59 PM

Allocated
Amount
$20,642,090.
00




* (required) Entity Type:®

Available Chosen

Subrecip...
Benefici... 4

Contract...

* (required)Is the subrecipient
registered in SAM.gov?@
--Non... «

Create Subrecipient, Beneficiary, or Contractor

My Subrecipients
> Filters
Records perpage: 10 * Page: 1 of 1
Name v ID v UEI v TIN
1 Waggoneer Eng... RCP-042759 64059120¢

b

& Download as CSV

Project Overview Next
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Subawards or Direct Payments

Please provide general information for each Subaward or Direct
Payment of federal funding greater than $50,000 provided under
this program. You will need to provide detailed information on the
amount, date, period and place of performance, and a brief
description of the Subaward or Direct Payment and its underlying
eligible use. In addition, you will also associate the Subaward or
Direct Payment with the relevant Project/FAIN and Subrecipient.

Please note: The term subaward in the title of this module reflects the broader
definition that includes contracts, grants, loans, direct payments, and others.
Recipients should use the “Subaward Type” dropdown to more specifically identify
the type of agreement being captured.”

Subaward Type drop-down picklist includes the following choices:

e Contract: Purchase order

e Contract: Delivery order

e Contract: Blanket Purchase Agreement

e Contract: Definitive contract

e Grant: Lump sum Payment(s)

e Grant: Reimbursable

e Loan - Maturity prior to 12/31/26 with planned forgiveness (please see note
below on use of loans)

e Loan - Maturity prior to 12/31/26 without planned forgiveness (please see note
below on use of loans)

e Loan - Maturity past 12/31/26 with planned forgiveness (please see note below
on use of loans)

e Loan - Maturity past 12/31/26 without planned forgiveness (please see note
below on use of loans)

e Direct Payment

e Transfer: Lump Sum Payment(s)

¢ Transfer: Reimbursable

Subaward Information

* (requir__ed) Project N_ame:o FAIN:

Q. Search Projects...

Bulk Uploads

> Help

i)

> Legend

Record
Details

Status
Draft

Report
Name
SLT-3349-P&E
Report-Q4
2022

Report Type
Project and
Expenditure
Report

Report
Period
Quarter 4
2022
(October-
December)

Reporting
Period Start
Date
10/1/2022

Reporting
Period End
Date
12/31/2022

Submission
Deadline

1/31/2023
10:59 PM

Allocated
Amount
$20,642,090.
00




& Download Subaward Template
Manual Entry

* (required) Subrecipient
Name:

Q Sn;arg:hﬁReciphiegts...”

f (req»yired)s_uvbaward No:e

* (requirgd_)vSubaward Type:o

_ --None-- ] v

* (required) Subaward
Amount (gllv'_)"ligation):o

f (required) Subaward Date:@

—

* (required) Period of

I?erformaﬂnce Stg;jtﬂ;"o )
* (required) Period of
PerformanceEnd:e

&, Subaward Bulk Upload

* (required) Place of
Performance Address 1:0

Place of Performance
Address2:0

Place of Performance
Address 30

* (required) Place of
Performance City:@

fgﬁquired)stafg;o -
_~None-- v

* (required) Place of
Performance Zip:@

Place of Performance Zip+4:
o

* (required) Brief description of Subaward and its underlying

’elAi‘gi“I‘)Al_g use (750 characters):o_

Create Subaward or Direct Payment



My Subawards

> Filters

Records per page: 10 * Page: 1 of 1

ProjectNa... ~+ AwardNo ~ AwardAm... v Subrecipie

1 Broadband - Fib... BBJULY2022C..  $270,000.00 Waggoneer
2 Broadband - Fib... BB15680ASMT $206,000.00 Waggoneer
3 Broadband - Fib... BBJUNE2022C... $133,000.00 Waggoneer

B

»

& Download as CSV

Project Overview Next
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Expenditures

In the below section, users should provide details for each
expenditure of program funds. You will need to associate each
expenditure with a Project, Subaward, and Subrecipient record
created in the previous tabs. In addition, you will need to provide
the amount of the expenditure(s) and relevant dates. In addition,
grantees and creditors receiving federal program funds will also
have to answer some additional, Subaward specific questions.

Expenditures for Awards > $50,000
In the below section, please provide further detail on each
expenditure for awards of $50,000 or more.

Project Nameg
Search Project: g
Bulk Uploads

" Download Bulk
- Upload Template

. Upload Bulk
- Upload Template

Manual Entry

Subaward
Typeo

Subaward Subrecipient

Amountg@

Subaward No
Nameg@

Expenditure
End @

Expenditure
Amount @

Expenditure
Start @

& _
Complete this field.

Cumulative Expenditures
$347,361.73

Add Expendit...

> Help
> Legend

Record
Details

Status
Draft

Report
Name
SLT-3349-P&E
Report-Q4
2022

Report Type
Project and
Expenditure
Report

Report
Period
Quarter 4
2022
(October-
December)

Reporting
Period Start
Date
10/1/2022

Reporting
Period End
Date
12/31/2022

Submission
Deadline

1/31/2023
10:59 PM

Allocated
Amount
$20,642,090.
00




Create Expenditure

> Filters

Records per page: 10 Page: 1 of1

v

Project Name » SubawardNo \ Obligation... -+ Expenditure...

Broadband - Fibe... BBJUNE2022CONT $133,000.00 $40,00(
Broadband - Fibe... BBJULY2022CONT $270,000.00 $30,00¢
Broadband - Fibe... BBJUNE2022CONT $133,000.00 $9.29¢
Broadband - Fibe... BBJULY2022CONT $270,000.00 $28,36:
Broadband - Fibe... BB15680ASMT $206,000.00 $160,88!
Broadband - Fibe... BB15680ASMT $206,000.00 $45,11¢
Broadband - Fibe... BBJUNE2022CONT $133,000.00 $33,70¢

¢ i i = »

& Download as CSV

Aggregate Expenditures for Awards <
$50,000

For disbursements less than $50,000, please provide the
aggregate expenditures and obligations for the current
reporting period and total to date. Your organization must
assign project and subaward identifiers to each aggregate
expenditure.

Project Nameg@
@ Search Projects...
Bulk Uploads

& Download Bulk Upload Template
&, Upload Bulk Upload Template

Manual Entry



Subaward Type (Aggregates) @

--None-- w

Total Period Obligation Amount
(i ]

Cumulative Obligations
$202.46

Create Expenditure

Total Period Expenditure
Amountg@

Cumulative Expenditures
$202.46

» Filters
Records perpage: 10 ;  Page: 1 of 1
ProjectNa... »» Subaward... »~» TotalPerio... -+ Total Perio
1 Broadband - Fib... Aggregate of Dir... $202.46 $z

»

& Download as CSV

Payments to Individuals

For disbursements to individuals, please provide the
aggregate expenditures and obligations for the current
reporting period and total to date.

Project Name

(i)
Search

Bulk Uploads
Download Bulk Upload
Template

[«

Manual Entry

Total Period Obligation Amount

& Upload Bulk Upload Template

Total Period Expenditure



|

[:) Amounte
| | ;
Cumulative Obligations Cumulative Expenditures
Create Expenditure
Project Overview E Next
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Revenue Replacement

Recipients will have the option below to update or provide
information associated with revenue replacement.

Depending on your answer to the question, “Is your jurisdiction
electing to use the standard allowance of up to $10 million for
identifying the revenue loss?” you will be asked conditional
questions.

Please note: during the period of performance covered by this
report, the Interim Final Rule still applies. However, if your
jurisdiction is calculating your “Revenue loss due to COVID-19
Public Health Emergency” using your fiscal year, you may do so by
completing the “Fiscal Year End Date” field and entering your
revenue loss in the same “Revenue loss due to COVID-19 Public
Health Emergency” field.

If that situation applies to you, please make clear in the “Provide an
explanation...” text box that you are using fiscal year for your
calculation.

Revenue Replacement Key Inputs

*(required) Is your jurisdiction electing to use the standard
allowance of up to $10 million, not to exceed your total
award allocation, for identifying revenue loss?

Yes v

If a recipient's total is $10 million or greater, the recipient
may enter in the amount of revenue loss the recipient is
electing up to $10 million.

If a recipient's total allocation is less than $10 million, the
recipient may enter in the amount of revenue loss the
recipient is electing up to your total allocation.

* (required) Revenue Loss Due to Covid-19 Public Health
Emergency

MmMaen AnA AC

> Help
> Legend

Record
Details

Status
Draft

Report
Name
SLT-3349-P&E
Report-Q4
2022

Report Type
Project and
Expenditure
Report

Report
Period
Quarter 4
2022
(October-
December)

Reporting
Period Start
Date
10/1/2022

Reporting
Period End
Date
12/31/2022

Submission
Deadline
1/31/2023
10:59 PM

Allocated
Amount
$20,642,090.
00




N DRVRYLY VAV Uy

* (required) Were Fiscal Recovery Funds used to make a
deposit into a pension fund?
‘No |

* (required) Please provide an explanation of how revenue
replacement funds were allocated to government services

Explanation

Build and/or repair roads and bridges

Save

Project Overview ! ! Next
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Certification

Review

Total Expenditures:
$347,564.19

Total Obligations:
$609,202.46

Total Number of Projects: 1
Total Number of Subawards: 3
Total Number of Expenditures: 8

Project Overview Statuse

| Project | Obligation | Expenditure
Status | Status Status
Complete 1| 1 1
Incomplete 0 i 0 0

Statement

| certify that the information provided is accurate and
complete after reasonable inquiry of people, systems, and
other information available to the SLFRF recipient. The
undersigned acknowledges that any materially false,
fictitious, fraudulent statement, or representation (or
concealment or omission of a material fact) in this submission
may be the subject of criminal prosecution under the False
Statements Accountability Act of 1996, as amended, 18 USC
1001, and also may subject me and the SLFRF Recipient to
civil penalties, damages, and administrative remedies for
false claims or otherwise (including under 31 USC 3729 et
seq.) The undersigned is an authorized representative of the
SLFRF Recipient with authority to make the above
certifications and representations on behalf of the SLFRF
Recipient.

> Help
> Legend

Record
Details

Status
Draft

Report
Name
SLT-3349-P&E
Report-Q4
2022

Report Type
Project and
Expenditure
Report

Report
Period
Quarter 4
2022
(October-
December)

Reporting
Period Start
Date
10/1/2022

Reporting
Period End
Date
12/31/2022

Submission
Deadline
1/31/2023
10:59 PM

Allocated
Amount
$20,642,090.
00




By signing this report, the Authorized Representative for
Reporting acknowledges in accordance with 31 CFR 35.4(c)
that recipients shall provide to the Secretary periodic reports
providing detailed accounting of the uses of funds, as
applicable, all modifications to a State's or Territory’s tax
revenue sources, and such other information as the Secretary
may require for the administration of this program. In
addition to regular reporting requirements, the Secretary
may request other additional information as may be
necessary or appropriate, including as may be necessary to
prevent evasions of the requirements of this program. False
statements or claims made to the Secretary may result in
criminal, civil, or administrative sanctions, including fines,
imprisonment, civil damages and penalties, debarment from
participating in Federal awards or contracts, and/or any other
remedy available by law.

Name of Current Login User

The information for the currently signed in user will
populate as the Authorizer of this submittal. Only those in
Role of Authorized Representative for Reporting or
Authorized Representative on the Submission record will
have access to Certify and Submit.

i

Name: Telephone:

NASON WHITE

Title: Email:

Comptroller N cherryscheppel@gmail.com
(mailto:cherryscheppel@gmail.com) |

 Back | Certify and Submit
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